
วารสารวิจัยและพัฒนา มจธ. ปีที่ 40 ฉบับที่ 4 ตุลาคม - ธันวาคม 2560 611

บทคัดย่อ

 กองพล ชุนเกาะ1 และ วชรภูมิ เบญจโอฬาร2*

มหาวิทยาลัยเทคโนโลยีสุรนารี อ.เมือง จ.นครราชสีมา 30000

 ความรู้ท่ีเกิดจากประสบการณ์การปฏิบัติงานของแต่ละบุคคลถือเป็นหนึ่งในทรัพยากรท่ีส�าคัญของบริษัทก่อสร้าง 

โดยเฉพาะความรู้ด้านความปลอดภัยที่ได้รับจากการเผชิญกับเหตุการณ์ปัญหาหรืออุบัติเหตุที่เกิดขึ้นภายในโครงการ 

ก่อสร้างของกลุม่บุคคลทีมี่ส่วนเก่ียวข้องกับงานก่อสร้างโดยตรง  สามารถน�ามาใช้เป็นข้อมูลส�าหรับป้องกันการเกดิเหตกุารณ์ 

ปัญหาหรืออบัุตเิหตใุนลักษณะคล้ายเดิมได้  จากผลการส�ารวจวธิกีารจดัการความรู้ด้านความปลอดภยัเดิมของบริษทัก่อสร้าง 

แสดงให้เห็นว่าบริษัทก่อสร้างส่วนใหญ่ยังขาดแนวทางส�าหรับรวบรวมและใช้ประโยชน์จากความรู้ที่มีอยู่เหล่านั้น งานวิจัยนี ้

จึงมีวัตถุประสงค์เพื่อพัฒนาวิธีการจัดการความรู้ด้านความปลอดภัยในงานก่อสร้างที่ชื่อว่า Building Information Modeling  

based Construction Safety Knowledge Management (BIM-CSKM) โดยใช้แนวทางการจัดการความรู้ร่วมกับการใช้แบบ 

จ�าลองสารสนเทศอาคารส�าหรับรวบรวม จัดเก็บ และน�าเสนอความรู้ด้านความปลอดภัยของบุคคลภายในบริษัทก่อสร้าง 

ทั้งนี้ผู้วิจัยได้น�าวิธีการดังกล่าวไปทดสอบกับกลุ่มตัวอย่างจ�านวน 10 ท่านและได้ผลลัพธ์คือความรู้ด้านความปลอดภัยใน 

แต่ละพื้นที่เสี่ยงภายในโครงการก่อสร้าง 5 บริเวณได้แก่ 1) บริเวณช่องเปิดที่พื้น 2) บริเวณรัศมีการท�างานของปั้นจั่นหอสูง 

3) บริเวณพื้นที่กองวัสดุ 4) บริเวณพื้นปฏิบัติงานที่ยกสูงหรือนั่งร้าน 5) บริเวณหลุมขุด
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 Individual experience is one of the most important resources of a construction company,  
especially in terms of the construction safety. Such information can be used to prevent similar problems or 
accidents that may happen. Most construction companies, however, stilllack guidelines for collecting and  
applying existing knowledge in their own company. Therefore, this research aimed to improve the methods  
for construction safety knowledge management and arrived at the so-called Building Information Modeling  
based Construction Safety Knowledge Management (BIM-CSKM) in order to put the work experience of  
a group of people together and then present it to all involved parties. The test results on 10 individuals yielded 
the safety knowledge in five risk areas ofa construction project, i.e., floor openings, radius of tower cranes, 
material stockpiles, scaffolding structures and excavations.
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1. บทน�า 
 ความปลอดภัยในงานก่อสร้างเป็นสิ่งหนึ่งท่ีถูกบริษัท 

ก่อสร้างมองข้ามหรือเลอืกทีจ่ะด�าเนนิการเป็นล�าดับสุดท้าย  

โดยสิ่งหนึ่งที่สามารถอธิบายถึงความปลอดภัยในงาน 

ก่อสร้างได้ก็คือ สถิติการประสบอันตรายหรือเจ็บป่วย 

ประเภทกิจการก่อสร้างในช่วงปี 2554 - 2558 รวบรวมโดย 

ส�านกังานประกันสงัคม [1] ซึง่มีจ�านวนลูกจ้างประสบอนัตราย 

เฉลี่ย 8,647 รายต่อปี หรือร้อยละ 7.58 ต่อปี ของจ�านวน 

การประสบอันตรายทั้งหมดโดยประเภทกิจการก่อสร้างมี 

จ�านวนลูกจ้างประสบอันตรายหรือเจ็บป่วยจากการท�างาน 

มากที่สุดจากทุกประเภทกิจการในส่วนของปัจจัยที่ส่งผล 

ท�าให้เกิดปัญหาหรืออบัุตเิหตใุนงานก่อสร้างส่วนใหญ่เกิดขึน้ 

จากการด�าเนนิงานภายในบรเิวณพืน้ทีโ่ครงการก่อสร้างเช่น  

การจัดสรรพื้นท่ีโครงการ การวางแผนงานก่อสร้าง การ 

ปฏิบัตงิานส่วนบุคคล รวมไปถงึการบริหารจดัการด้านความ 

ปลอดภัย

 ในปัจจบัุนการจดัการความรู้ (Knowledge Management)  

เป็นสิง่หนึง่ท่ีบริษทัก่อสร้างมองเหน็ความส�าคญั และมุ่งหวงั 

ท่ีจะน�ามาใช้จัดการกับความรู้ที่มีอยู่อย่างมีประสิทธิภาพ 

และเกิดประโยชน์มากท่ีสุด Toyama [2] ให้ค�านิยามการ 

จัดการความรู้ว่าเป็นการจัดการเพื่อเอื้อให้เกิดความรู้ใหม่ 

โดยใช้ความรู้เดิมทีมี่อยู่ของคนในองค์กรอย่างเป็นระบบเพือ่ 

พัฒนาให้มีความได้เปรียบเหนือคู่แข่งทางธุรกิจ Malhotra  

[3] ให้ค�านิยามการจัดการความรู้ว่าเป็นส่ิงส�าคัญที่ท�าให้ 

องค์กรเกิดการปรับตัวให้สามารถอยู่รอดและแข่งขันได ้

ภายใต้สภาพแวดล้อมทีเ่ปลีย่นแปลงไป และจ�าเป็นทีจ่ะต้อง 

มีกระบวนการในการผสมผสานความสามารถของเทคโนโลย ี

สารสนเทศกับความสามารถของคนเข้าด้วยกันอย่างเหมาะสม 

จากลักษณะการด�าเนินงานก่อสร้างในแต่ละโครงการส่งผล 

ท�าให้เกิดความรู้ต่าง ๆ หนึ่งในนั้นคือ ความรู้ด้านความ 

ปลอดภยัจากประสบการณ์การปฏิบัตงิานส่วนบุคคลซึง่เป็น 

ข้อมูลที่มีค่าขององค์กรทั้งนี้มีงานวิจัยของ Lin และ Lee [4]  

ท�าการพัฒนาแนวทางปฏิบัติส�าหรับการจัดการความรู้ใน 

งานก่อสร้าง โดยสร้างวิธีการรวบรวมและแบ่งปันความรู้ 

ในกลุ่มวศิวกรโดยใช้กระดานสนทนาออนไลน์เป็นศนูย์กลาง 

ส�าหรับแลกเปล่ียนความรู้และเป็นแหล่งข้อมูลส�าหรับวิศวกร 

ท่ียังไม่มีประสบการณ์ โดยทีว่ศิวกรสามารถน�าข้อมูลเหล่านัน้ 

มาใช้ส�าหรับป้องกันข้อผิดพลาดท่ีมีโอกาสเกิดขึ้นภายใน 

บริเวณโครงการก่อสร้างของตนเอง จากงานวิจัยจะเห็นว่า 

การรวบรวมและแบ่งปันความรู้ ข้อมูลจะถูกจ�ากัดเฉพาะ 

กลุ่มวิศวกร ซึ่งยังคงขาดการแบ่งปันความรู้จากผู้มีส่วน 

เก่ียวข้องกับงานก่อสร้างในกลุ่มอื่น โดยส่งผลท�าให้การ 

จัดการความรู้ยังคงขาดประสิทธิภาพ และไม่ก่อให้เกิดการ 

ใช้ประโยชน์จากความรู้ที่มีอยู่ทั้งหมดได้อย่างแท้จริง

 ทั้งนี้เทคโนโลยีเป็นหน่ึงในองค์ประกอบที่ส�าคัญที่สุด 

ส�าหรับการจัดการความรู้ โดยสามารถช่วยท�าให้ให้บริษัท 

ด�าเนินการค้นหา รวบรวม และแบ่งปันความรู้ได้อย่าง 

รวดเร็วและมีประสทิธภิาพ ในปัจจบัุนแบบจ�าลองสารสนเทศ 

อาคาร (Building Information Modeling, BIM) เป็นหนึ่ง 

ในรูปแบบเทคโนโลยทีีไ่ด้รบัความสนใจ และถูกน�ามาใช้เป็น 

เคร่ืองมือส�าหรับบริหารจัดการข้อมูลทั้งในช่วงขั้นตอนการ 

ออกแบบและขัน้ตอนการก่อสร้างการประยกุต์ใช้แบบจ�าลอง 

สารสนเทศอาคารในช่วงการก่อสร้างเป็นการปฏิบัติตาม 

แนวคิดการก่อสร้างตามสถานการณ์และสภาพแวดล้อม 

เสมือนจริง โดยจะต้องสร้างองค์ประกอบจ�าลองของอาคาร 

ให้ได้ข้อมูลที่ครบถ้วนสมบูรณ์ เพื่อส�าหรับน�าไปบูรณาการ 

ในการท�างานได้อย่างแท้จริง และเกิดประสิทธิภาพสูงสุด  

งานวิจัยของ Ding และคณะ [5] ได้พัฒนารูปแบบการใช ้

แบบจ�าลองสารสนเทศอาคารส�าหรับบริหารจัดการข้อมูล 

ความเสีย่งภายในโครงการก่อสร้างโดยใช้เหตผุลและความรู้ 

ส่วนบุคคลเป็นข้อมูลในการจัดการแก้ไขปัญหาด้านความ 

เสี่ยง และใช้เทคโนโลยีความสัมพันธ์ส�าหรับจัดกลุ่มและ 

เชื่อมโยงความสัมพันธ์ของแนวความคิด รวมไปถึงสร้าง 

แบบจ�าลองสารสนเทศอาคาร ส�าหรับน�าเสนอข้อมูลความ 

เสี่ยงและข้อผิดพลาดท่ีเกิดข้ึนในงานก่อสร้างจากงานวิจัย 

จะเห็นว่าการน�าเสนอข้อมูลด้านความปลอดภัยควรจะ 

พัฒนาหรือสร้างวิธีการน�าเสนอข้อมูลในรูปแบบอ่ืนๆ ด้วย  

เช่น การน�าเสนอข้อมูลผ่านภาพเคล่ือนไหว ซึ่งจะท�าให ้

เกิดความเข้าใจในข้อมูลและเกิดการเรียนรู้จากข้อมูลได้ 

อย่างมีประสิทธิภาพ

 จากข้อมูลเหล่านี้ผู้วิจัยมองเห็นว่าบริษัทก่อสร้างควร 

ทีจ่ะให้ความส�าคญักับการจดัการความรู้ด้านความปลอดภยั 

ภายในโครงการก่อสร้างเป็นอย่างมากผู้วิจัยจึงเลือกที่จะ 

พัฒนาวิธีส�าหรับรวบรวมและน�าเสนอความรู้ท่ีมีอยู่ภายใน 

บริษัทก่อสร้างโดยใช้กระบวนการจัดการความรู้ 7 ขั้นตอน  

ของส�านักงานคณะกรรมการการพัฒนาระบบราชการ [6]  
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ร่วมกับการใช้แบบจ�าลองสารสนเทศอาคารเป็นแนวทาง 

ส�าหรับพัฒนาวิธีการขึ้นมาใหม่ท้ังนี้ผู้วิจัยหวังว่าวิธีการ 

จดัการความรูดั้งกล่าวท่ีน�าเสนอจะช่วยท�าให้บรษิทัก่อสร้าง 

สามารถน�าความรู้ท่ีมีอยู่ออกมาใช้ประโยชน์ได้อย่างเต็มที ่

และมีประสิทธิภาพ

2.  ขั้นตอนการด�าเนินงานวิจัย 
 วตัถปุระสงค์ของงานวจิยันีคื้อ การพฒันาวธิกีารจดัการ 

ความรู้ด้านความปลอดภัยในงานก่อสร้างด้วยแบบจ�าลอง 

สารสนเทศอาคาร ทีมี่ชือ่ว่า Building Information Modeling  

based Construction Safety Knowledge Management 

(BIM-CSKM) โดยผู้วิจัยได้แบ่งขั้นตอนการด�าเนินงานวิจัย 

ออกเป็น 3 ขั้นตอนดังนี้

 ขั้นตอนที่ 1 การส�ารวจวิธีการจัดการความรู้ด้านความ 

ปลอดภัยเดิม

 ด�าเนินการสัมภาษณ์กลุ่มบุคคลท่ีสามารถให้ค�าตอบ 

เก่ียวกับความปลอดภยัในงานก่อสร้างได้โดยตรง (Personal  

interview) ได้แก่ ผูจ้ดัการโครงการ จ�านวน 1 ท่าน เจ้าหน้าที ่

ความปลอดภยัในการท�างาน จ�านวน 4 ท่าน วศิวกรโครงการ  

จ�านวน 2 ท่าน โฟร์แมนควบคุมงาน จ�านวน 2 ท่าน และ 

คนงานจ�านวน 1 ท่าน โดยผู้ให้สัมภาษณ์ทั้ง 10 ท่านจะต้อง 

มีประสบการณ์การท�างานในบริษัทก่อสร้างอย่างน้อย 1 ปี  

เพื่อสอบถามข้อมูลเก่ียวกับการจัดการความรู้ด้านความ 

ปลอดภัยเดิมของบริษัท ได้แก่ ลักษณะของกิจกรรมการ 

แลกเปลีย่นความรูก้ารเสนอวธิีป้องกนัหรอืแก้ไขปัญหาจาก 

บุคคล การร่วมมือกันระหว่างบุคคลภายในบริษทัการบริหาร 

จดัการและการน�าเสนอข้อมูลความรู้ท่ีมีอยูซ่ึง่ผลการส�ารวจ 

ข้อมูลในขั้นตอนนี้สามารถอธิบายลักษณะของการจัดการ 

ความรู้เดิมของบริษัทก่อสร้างและใช้เป็นข้อมูลส�าหรับ 

พัฒนา BIM-CSKM ต่อไป

 ขั้นตอนที่ 2 การพัฒนาBIM-CSKM

 ด�าเนนิการพฒันา BIM-CSKM ส�าหรับให้บรษิทัก่อสร้าง 

น�าไปใช้บริหารจัดการด้านความปลอดภัยภายในโครงการ 

ก่อสร้างโดยมีแนวทางการพฒันามาจากกระบวนการจดัการ 

ความรู้ของส�านกังานคณะกรรมการการพฒันาระบบราชการ  

[6] ซึ่งกระบวนการ BIM-CSKM ประกอบไปด้วย 5 ขั้นตอน 

ลักษณะเป็นการรวบรวม วิเคราะห์ และน�าเสนอความรู้ด้าน 

ความปลอดภัยที่เกิดจากประสบการณ์การปฏิบัติงานใน 

แต่ละหน้าที่ของบุคคล โดยการน�าเสนอความรู้ถูกสร้างขึ้น 

ด้วยการจ�าลองภาพสามมิติแสดงเหตุการณ์ปัญหาหรือ 

อุบัติเหตุโดยใช้โปรแกรม SketchUp เวอร์ชั่น 2017 ของ 

บริษัท Trimble ท้ังนี้ในแต่ละขั้นตอนจะถูกด�าเนินการโดย 

นายหน้าความรู้ (Knowledge Agent) ซึ่งเป็นบุคคลที่ท�า 

หน้าที่สร้างและแบ่งปันความรู้เพื่อลดช่องว่างของความรู้ 

ระหว่างบุคคลในแต่ละฝ่ายของบริษัท [7]

 ขั้นตอนที่ 3 การทดสอบ BIM-CSKM

ด�าเนินการทดสอบตามกระบวนการของ BIM-CSKM ทั้ง 5  

ขั้นตอนโดยใช้กลุ่มตัวอย่างเดียวกันกับข้ันตอนการส�ารวจ 

วิธีการจัดการความรู้ด้านความปลอดภัยเดิม เพื่อค้นหา 

ตัวอย่างความรู้ส�าหรับน�าไปสร้างการน�าเสนอความรู้ด้วย 

แบบจ�าลองสารสนเทศอาคาร และท�าการประเมินวิธีการ 

เรียนรู้โดยสอบถามความคิดเห็นกลุ่มตัวอย่างเพื่อหาข้อ 

บกพร่องส�าหรับน�าไปปรับปรุงและแก้ไขให้ได้วธิกีารท่ีดีท่ีสดุ

3.  ผลการศึกษา
 3.1  ผลการส�ารวจวิธีการจัดการความรู้ด้าน 

   ความปลอดภัยเดิม 

 ผลการสัมภาษณ์ข้อมูลการด�าเนินการจัดการความรู้ 

ด้านความปลอดภัยในงานก่อสร้างจากกลุ่มตัวอย่างท้ัง 10  

ท่านมีรายละเอียดดังต่อไปน้ี กลุ่มตัวอย่างจ�านวน 9 ท่าน 

กล่าวว่าบรษิทัของพวกเขาใช้กจิกรรมสนทนาความปลอดภยั 

(Safety talk) เป็นช่องทางส�าหรับน�าเสนอข้อมูลด้านความ 

ปลอดภัย โดยลักษณะของการน�าเสนอข้อมูลใช้เอกสารระบ ุ

ข้อความหรือรปูภาพเป็นสือ่ประกอบการสนทนาและพวกเขา 

ให้ความสนใจที่จะเข้าร่วมกิจกรรมนี้กลุ่มตัวอย่างจ�านวน 8  

ท่านกล่าวว่าความรู้ด้านความปลอดภัยส่วนบุคคลจะถูก 

ถ่ายทอดผ่านการพดูคยุขณะปฏบิตังิานโดยเป็นการอธบิาย 

วิธีปฏิบัติงานท่ีปลอดภัยจากบุคคลที่มีประสบการณ์ใน 

หน้าที่เดียวกันทั้งนี้กลุ่มตัวอย่างทั้ง 10 ท่านมีความคิดเห็น 

ไปในแนวทางเดียวกันว่าบริษัทของพวกเขายังขาดการใช้ 

เทคโนโลยสี�าหรับจดัการกับข้อมูลความรูด้้านความปลอดภยั 

ที่อยู่ในตัวของแต่ละบุคคล (Tacit Knowledge) และมีความ 

สนใจที่จะน�าเทคโนโลยีมาใช้ร่วมกับการจัดการความรู้
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 3.2 ผลการพัฒนา BIM-CSKM 

 งานวิจัยนี้ได้พัฒนา BIM-CSKM ซึ่งเป็นวิธีการจัดการ 

ความรู้ด้านความปลอดภัยส�าหรับงานก่อสร้างโดยกระบวน 

การของ BIM-CSKM ประกอบไปด้วย 5 ขั้นตอน ได้แก่

 1)  การจัดท�าเครื่องมือค้นหาความรู้  

  (Knowledge Search Tools)

  ด�าเนินการจัดท�าแบบสอบถามโดยเจ้าหน้าที่ความ 

ปลอดภัยในการท�างานของบริษัทส�าหรับใช้เป็นเครื่องมือ 

ในการรวบรวมความรู้ท่ีมีอยู่ในตัวบุคคล ซึ่งแบบสอบถาม 

แบ่งออกเป็น 2 ตอนได้แก่ตอนที่ 1ค�าถามแบบเลือกตอบ 

ในแบบบันทึก (Checklist) สอบถามข้อมูลเกี่ยวกับประสบ- 

การณ์ในการท�างานและการประสบปัญหาหรืออุบัติเหต ุ

ในงานก่อสร้าง เพื่อต้องการทราบว่า ลักษณะการประสบ 

ปัญหาหรืออุบัติเหตุในแต่ละหน้าท่ีของบุคคลว่ามีความ 

เหมือนหรือแตกต่างกันอย่างไรตอนที่ 2 ค�าถามแบบปลาย 

เปิด (Open-ended question) ส�าหรับสอบถามความรู้ด้าน 

ความปลอดภัยที่เกิดจากประสบการณ์การปฏิบัติงานใน 

พื้นที่เสี่ยง 5 บริเวณภายในโครงการก่อสร้างได้แก่ บริเวณ 

ที่ 1 ช่องเปิดที่พื้น (floor opening) บริเวณที่ 2 รัศมีการ 

ท�างานของปั้นจั่นหอสูง (radius of tower cranes) บริเวณ 

ที่ 3 พื้นท่ีกองวัสดุ (material stockpiles) บริเวณท่ี 4  

พื้นปฏิบัติงานที่ยกสูงหรือนั่งร้าน (scaffolding structures)  

และบริเวณที่ 5 หลุมขุด (excavations)

 2) การค้นหาความรู้ (Knowledge Identification)

  ด�าเนินการค้นหาความรู้โดยให้เจ้าหน้าที่ความ 

ปลอดภัยในการท�างานน�าแบบสอบถามจากขั้นตอนการ 

จัดท�าเครื่องมือค้นหาความรู้มาใช้เป็นเคร่ืองมือในการ 

สัมภาษณ์บุคคลในบริษัทส�าหรับแบบสอบถามตอนท่ี 1  

ผู้ให้สัมภาษณ์จะต้องตอบแบบสอบถามด้วยตนเอง โดย 

เลือกค�าตอบข้อมูลประสบการณ์การท�างานในแบบบันทึก 

และระบุค�าตอบการประสบปัญหาหรืออุบัติเหตุส่วนแบบ 

สอบถามตอนท่ี 2 ใช้วิธีการสัมภาษณ์แบบมีโครงสร้าง 

แน่นอน (Structured Interview) โดยผู้ให้สัมภาษณ์จะต้อง 

ตอบค�าถามในลักษณะแบ่งปันประสบการณ์ความรู้ที่เกิด 

จากการปฏิบัตงิานในแต่ละพืน้ทีเ่ส่ียงภายในโครงการก่อสร้าง  

และที่ได้พบเจอกับเหตุการณ์ต่างๆ โดยเฉพาะเหตุการณ ์

อุบัติเหตุจากการปฏิบัติงานเกินความสามารถของคนงาน  

[8] เช่น การปฏิบัติงานข้ามขั้นตอน และการปฏิบัติงานโดย 

ละเลยกฎของความปลอดภัย

 3) การวิเคราะห์ความรู้ (Knowledge Analysis)

  จากข้อมูลการสัมภาษณ์ด้วยแบบสอบถามตอนที่ 1 

และตอนที่ 2 น�ามาวิเคราะห์โดยเจ้าหน้าท่ีความปลอดภัย 

ในการท�างานด้วยวิธีการตีความสร้างข้อสรุปแบบอุปนัย  

(inductive) โดยพิจารณาลักษณะร่วมกันของข้อมูลปัญหา 

หรืออุบัติเหตุที่เกิดขึ้นภายในโครงการก่อสร้างทั้งนี้ผลการ 

วิเคราะห์ข้อมูลจะต้องแสดงได้ถึงรายละเอียดของปัญหา 

หรืออุบัตเิหตแุละการใช้ประสบการณ์ส่วนบุคคลในการแก้ไข 

ปัญหาหรืออุบัติเหตุท่ีเกิดขึ้นเหล่านั้นรวมไปถึงจะต้องเป็น 

ข้อมูลท่ีสามารถน�าเสนอด้วยภาพเคล่ือนไหวในแต่ละ 

เหตุการณ์ได้อย่างชัดเจน

 4)  การสรา้งวธิเีขา้ถงึความรู ้(Knowledge Access)

  ความรู้ที่อยู่ในตัวของแต่ละบุคคลเป็นส่ิงที่สื่อสาร 

หรือถ่ายทอดออกมาในรูปแบบลายลักษณ์อักษรได้ยาก [9]  

จึงจ�าเป็นท่ีจะต้องสร้างรูปแบบการน�าเสนอข้อมูลด้วยการ 

แสดงภาพเคลือ่นไหวจากแบบจ�าลองสารสนเทศอาคารเพือ่ 

ท�าให้สามารถมองเห็นภาพและเกิดความเข้าใจในลักษณะ 

ของเหตุการณ์ปัญหาหรืออุบัติเหตุท่ีเกิดขึ้นในงานก่อสร้าง 

ได้ง่ายขึน้ ส�าหรับการสร้างวิธเีข้าถงึความรู้จะถกูด�าเนนิการ 

โดยพนักงานเขียนแบบ (Draftsman) ด้วยการใช้โปรแกรม  

SketchUp สร้างแบบจ�าลองสารสนเทศอาคารเพือ่ใช้ส�าหรับ 

จัดเก็บ น�าเสนอ และเป็นช่องทางในการเข้าถึงข้อมูลความรู ้

โดยมีขั้นตอนการสร้างแบบจ�าลองสารสนเทศอาคารด้วย 

โปรแกรม SketchUp ดังต่อไปนี้

  4.1 สร้างแบบจ�าลองโครงการก่อสร้าง จากแบบ 

แผนผังบริเวณก่อสร้าง (Site Layout) ประกอบไปด้วย  

ขอบเขตพื้นที่โครงการ ต�าแหน่งของอาคาร ส�านักงาน 

ควบคุมโครงการชั่วคราว ระบบสาธารณูปโภคชั่วคราว และ 

ต�าแหน่งที่ติดตั้งเครื่องจักร

  4.2 ก�าหนดต�าแหน่งของบริเวณพื้นที่เสี่ยงภายใน 

โครงการก่อสร้างท่ียังไม่ได้ด�าเนินงานด้านความปลอดภัย 

ลงในแบบจ�าลองสารสนเทศอาคารโดยก�าหนดหมายเลข 

พื้นที่เสี่ยงในแต่ละบริเวณดังรูปที่ 1 ซึ่งมีรายละเอียดดังนี้
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 บริเวณที่ 1 (หมายเลข 1) ได้แก่ ปล่องลิฟต์ ช่องบันได  

ช่องชาฟต์ 

 บริเวณที่  2 (หมายเลข 2) ได้แก่ รัศมีของปั้นจั่นหอสูง

 บริเวณที ่  3 (หมายเลข 3) ได้แก่ กองเหลก็ กองชิน้ส่วน 

อุปกรณ์ของนั่งร้าน กองไม้แบบ 

 บริเวณที่ 4 (หมายเลข 4) ได้แก่ นั่งร้านรับน�้าหนัก 

พื้นหล่อในที่ และ

 บริเวณที่ 5 (หมายเลข 5) ได้แก่ บ่อเก็บน�้าใต้ดิน  

เป็นต้น

รูปที่ 1  พื้นที่เสี่ยงทั้ง 5 บริเวณภายในโครงการก่อสร้าง

รูปที่ 2   หน้าต่างฟังก์ชัน Component Attributes และการ 

   ก�าหนดรายละเอยีดข้อมูลน�าเข้าในแต่ละช่องข้อมูล

รปูที ่3 หน้าต่างฟังก์ชนั Scenes และการก�าหนดรายละเอยีด 

  ข้อมูลน�าเข้าในแต่ละช่องข้อมูล

  4.3 จัดท�าภาพเคลื่อนไหว (Animation) ส�าหรับ 

แสดงเหตกุารณ์จ�าลองการเกิดปัญหาหรืออบัุตเิหตท่ีุเกิดข้ึน 

ภายในงานก่อสร้าง และแสดงวิธีการป้องกันหรือแก้ไข 

เหตุการณ์เหล่านั้นด้วยข้อมูลความรู้จากข้ันตอนการค้นหา 

ความรู้

  4.4 ประยกุต์ใช้งานฟังก์ชนั (Component Attributes)  

ส�าหรับน�าเข้าข้อมูลความรู้ด้านความปลอดภัยของแต่ละ 

บริเวณพื้นที่เส่ียงลงในแบบจ�าลองสารสนเทศอาคาร ซึ่ง 

สามารถเข้าใช้งานฟังก์ชันได้ดังนี้เลือกบริเวณพื้นที่เสี่ยง >  

Window > Component Attributes ทัง้นีก้�าหนดรายละเอยีด 

ข้อมูลน�าเข้าในแต่ละช่องข้อมูลของหน้าต่างฟังก์ชัน 

ดังรูปที่ 2

  4.5 ประยกุต์ใช้งานฟังก์ชนัScene ส�าหรับสร้างแบบ 

จ�าลองสารสนเทศอาคารให้สัมพันธ์กับกิจกรรมในแต่ละวัน 

โดยสามารถแสดงรายละเอียดเป็นไปตามช่วงเวลาของ 

แผนงานด้านความปลอดภัยและแผนงานก่อสร้างเพือ่ส�าหรับ 

การวิเคราะห์สถานการณ์ในแต่ละช่วงเวลา ซึ่งสามารถ 

เข้าใช้งานฟังก์ชันได้ดังนี้ View > Animation > Add Scene 

ทัง้นีก้�าหนดรายละเอยีดข้อมูลน�าเข้าในแต่ละช่องข้อมูลของ 

หน้าต่างฟังก์ชัน ดังรูปที่ 3
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  4.6 ประยุกต์ใช้งานฟังก์ชัน Component Options  

ส�าหรับแสดงรายละเอียดข้อมูลความรู้ด้านความปลอดภัย 

ในแต่ละบริเวณพื้นที่เสี่ยงภายในโครงการก่อสร้างโดยจะ 

แสดงเป็นข้อมูลท่ีน�าเข้าด้วยฟังก์ชนั Component Attributes  

ซึง่สามารถเข้าใช้งานฟังก์ชนัได้ดังนี ้เลือกบรเิวณพืน้ท่ีเสีย่ง  

> Window > Component Options

 5) การเรียนรู้ข้อมูลความรู้ (Learning)

  ใช้ช่วงเวลาของกิจกรรมการพูดคุยความปลอดภัย 

ประจ�าสัปดาห์หรือตามแผนงานกิจกรรมของบริษัท ส�าหรับ 

ให้เจ้าของความรู้ในท่ีนี้คือผู้ให้สัมภาษณ์น�าเสนอความรู้ท่ี 

อยู่ในตัวของแต่ละบุคคลด้วยภาพเคลื่อนไหวให้แก่บุคคล 

ของบริษัท ทั้งนี้เจ้าหน้าที่ความปลอดภัยในการท�างานต้อง 

นัดหมายเจ้าของความรู้ และจัดเตรียมพื้นที่ประชุมอุปกรณ ์

เคร่ืองฉายวีดิทัศน์ส�าหรับการน�าเสนอข้อมูลความรู้ใน 

กิจกรรมการพูดคุยความปลอดภัยนี้ด้วย

 3.3  ผลการทดสอบBIM-CSKM 

   จากการด�าเนินการน�า BIM-CSKM ไปทดสอบกับ 

กลุ่มตวัอย่างทัง้ 10 ท่าน ได้ผลการทดสอบตามวตัถปุระสงค์ 

ของงานวิจัยคือ ประสบการณ์ความรู้ด้านความปลอดภัย 

ในแต่ละบริเวณพื้นท่ีเส่ียงภายในโครงการก่อสร้างและผล 

การประเมินการเรียนรู้ด้วยแบบสอบถามความคิดเห็น ซึ่ง 

มีรายละเอียดดังต่อไปนี้

 1. ประสบการณ์ความรู้ด้านความปลอดภัยในแต่ละ 

บริเวณพื้นที่เสี่ยงภายในโครงการก่อสร้าง

 ผู้จัดการโครงการ ประสบการณ์การท�างานก่อสร้าง 

มากกว่า 10 ปี ให้ข้อมูลด้านความปลอดภัยบริเวณที่ 1 ช่อง 

เปิดท่ีพืน้ว่า การติดต้ังสญัลักษณ์ธงสขีาวแดงแทนการตดิตัง้ 

ราวเหล็กป้องกันการตกหล่นจะไม่สามารถป้องกันอุบัติเหต ุ

ที่เกิดจากแรงปะทะได้โดยตรง

 โฟร์แมนควบคุมงาน ประสบการณ์การท�างานก่อสร้าง 

มากกว่า 10 ปี ให้ข้อมูลด้านความปลอดภัยบริเวณท่ี 2  

รัศมีการท�างานของปั้นจั่นหอสูงว่าการเคล่ือนย้ายสิ่งของ 

โดยเลือกใช้วัสดุผูกมัดท่ีผิดขนาด จะท�าให้เกิดช่องว่าง 

ระหว่างวัสดุผูกมัดกับส่ิงของที่ต้องการเคล่ือนย้ายส่งผลให้ 

สิ่งของเกิดการร่วงหล่น

 เจ้าหน้าท่ีความปลอดภัยในการท�างาน ประสบการณ ์

การท�างานก่อสร้าง 1-3 ปี ให้ข้อมูลด้านความปลอดภัย 

บริเวณที่ 3 พื้นที่กองวัสดุว่า การจัดเก็บวัสดุรวมกันโดยไม ่

แยกประเภทหรือชนดิของวสัดุ เม่ือต้องการใช้งานจะสญูเสีย 

เวลาในการค้นหารวมไปถึงเส่ียงต่อการถูกวัสดุประเภทอื่น 

หล่นทับขณะคัดเลือกหรือเคลื่อนย้าย

 วิศวกรโครงการ ประสบการณ์การท�างานก่อสร้าง 6-10  

ปี ให้ข้อมูลความปลอดภยับรเิวณท่ี 4 พืน้ปฏิบัตงิานทีย่กสงู 

หรือนั่งร้านว่า การใช้แผ่นไม้แทนแผ่นทางเดินเหล็กบน 

นั่งร้านและขาดการผูกยึด หากมีการใช้งานแผ่นไม้จะเกิด 

การเคลื่อนตัวหรือพลิกเอียงท�าและเกิดอุบัติเหตุพลัดตก 

จากนั่งร้านได้

 หวัหน้าคนงาน ประสบการณ์การท�างานก่อสร้างมากกว่า  

10 ปี ให้ข้อมูลด้านความปลอดภัยบริเวณท่ี 5 หลุมขุดว่า 

เศษดนิหรอืเศษหินจากการปฏิบตัิงานรอบบริเวณปากหลมุ 

ขุดด้านบนล่วงหล่นใส่บุคคลท่ีปฏิบัติงานอยู่ภายในบริเวณ 

หลุมขุดด้านล่าง ซึ่งควรที่จะป้องกันโดยติดตั้งผ้าใบหรือ 

ตะแกรงป้องกันรอบบริเวณปากหลุมขุด

 จากข้อมูลดังกล่าว น�าไปสร้างวิธีเข้าถึงความรู้แสดง 

เหตกุารณ์ปัญหาหรืออบัุตเิหต ุและแสดงการใช้ประสบการณ์ 

ในการป้องกันและแก้ไขเหตุการณ์เหล่านั้นซึ่งรายละเอียด 

ของข้อมูลจะถูกแสดงผ่านฟังก์ชัน Component Options  

ของโปรแกรม SketchUp ดังรูปที่ 3 รวมไปถึงข้อมูลความรู ้

ดังกล่าวจะถูกแสดงด้วยภาพเคล่ือนไหวท่ีสร้างจากแบบ 

จ�าลองสารสนเทศอาคาร โดยเป็นการจ�าลองลักษณะการ 

เกิดเหตุการณ์และวิธีการแก้ไขหรือป้องกันเหตุการณ ์

เหล่านั้นทั้งนี้การแสดงข้อมูลด้วยภาพเคลื่อนไหวจะถูกน�า 

ไปใช้เป็นสื่อการเรียนรู้ท่ีเปรียบเสมือนกับการได้เรียนรู้ 

ข้อมูลความรู้ที่อยู่ในตัวของเจ้าของความรู้โดยตรง
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รปูที ่4 หน้าต่างฟังก์ชนั Component Options ส�าหรับแสดง 

  ข้อมูลความรู้

 2.  ผลการประเมินการเรียนรู้ด้วยแบบสอบถามความ 

คิดเห็น

  จากการสร้างการน�าเสนอข้อมูลความรู้ด้านความ 

ปลอดภัยด้วยการน�าเสนอผ่านแบบจ�าลองสารสนเทศอาคาร 

ด้วยภาพเคล่ือนไหวจ�าลองเหตุการณ์ปัญหาหรืออุบัติเหตุ  

ได้น�าไปแสดงให้แก่กลุ่มตัวอย่างจ�านวน 9 ท่านได้แก่  

ผู้จัดการโครงการ จ�านวน 2 ท่าน วิศวกรโครงการ จ�านวน  

1 ท่าน วิศวกรสนาม จ�านวน 2 ท่าน โฟร์แมนควบคุมงาน  

จ�านวน 2 ท่าน ผู้ตรวจสอบคุณภาพงาน จ�านวน 1 ท่าน  

และหัวหน้าคนงาน จ�านวน 1 ท่านโดยมีรายละเอียดของ 

การประเมินการเรียนรู้ดังต่อไปนี้

  การน�าเสนอข้อมูลด้านความปลอดภัยด้วยภาพ 

เคล่ือนไหวจากแบบจ�าลองสารสนเทศอาคารนั้นสามารถ 

ท่ีจะท�าให้บุคคลเกิดความเข้าใจในรายละเอียดของข้อมูล 

ได้มากขึ้น ซ่ึงการน�าเสนอด้วยวิธีการนี้มีความน่าสนใจซึ่ง 

ท�าให้บุคคลอยากเรียนรู้ และส่งผลท�าให้บุคคลเกิดความ 

ตระหนักท่ีจะปฏิบัติตามกฎความปลอดภัยของบริษัท โดย 

ส�าหรับงานก่อสร้างมีความจ�าเป็นที่จะต้องมีการน�าเสนอ 

ด้วยวิธีการดังกล่าวแต่ยังคงมีข้อจ�ากัดในหลายด้าน ได้แก่  

ภาษาทีใ่ช้ในการสือ่สารเนือ่งจากปัจจบุนัในส่วนของคนงาน 

มีความหลากหลายทางเชื้อชาติ และการด�าเนินการที ่

หลากหลายในแต่ละขั้นตอนของงานก่อสร้าง รวมไปถึง 

ลักษณะของสถานที่โครงการก่อสร้างและความพร้อมด้าน 

อุปกรณ์ที่ใช้ส�าหรับการน�าเสนอข้อมูลความรู้

4.  สรุปผลการศึกษา
 งานวิจัยนี้ได้พัฒนา BIM-CSKM ซึ่งเป็นวิธีการส�าหรับ 

รวบรวมและน�าเสนอความรู้ด้านความปลอดภัยที่อยู่ในตัว 

ของแต่ละบุคคลด้วยการจัดการความรู้ร่วมกับการใช้แบบ 

จ�าลองสารสนเทศอาคาร โดยการทดสอบ BIM-CSKM  

ได้ผลลัพธ์เป็นตัวอย่างประสบการณ์ความรู้ท่ีเกิดจากการ 

ปฏิบัติงานในพื้นที่เสี่ยง 5 บริเวณภายในโครงการก่อสร้าง  

ซึ่งความรู้ท่ีได้รับมีลักษณะของข้อมูลท่ีแตกต่างกันตาม 

หน้าท่ีและประสบการณ์การปฏิบัติงานของแต่ละบุคคล  

ทั้งนี้บริษัทก่อสร้างสามารถน�าวิธีการดังกล่าวไปใช้ส�าหรับ 

น�าเสนอความรู้ด้วยการแสดงข้อมูลในรูปแบบของภาพ 

เคลื่อนไหว ซึ่งจะท�าให้บุคคลในบริษัทเกิดการเรียนรู้และ 

น�าความรู้ที่อยู่ในตัวของแต่ละบุคคลไปใช้ประโยชน์ได้อย่าง 

เตม็ทีโ่ดยความรู้เหล่านัน้จะช่วยท�าให้บรษิทัก่อสร้างสามารถ 

ป้องกันการเกิดเหตุการณ์ปัญหาหรืออุบัติเหตุในลักษณะ 

ซ�้าเดิมขึ้นได้ หรือถ้าหากเกิดเหตุการณ์ในลักษณะซ�้าเดิม 

ก็จะสามารถแก้ไขและรับมือกับปัญหาเหล่านั้นได้อย่างมี 

ประสิทธิภาพ

 ผลการประเมินการเรียนรู้สรุปได้ว่า การจัดการความรู ้

ด้านความปลอดภัยในงานก่อสร้างด้วย BIM-CSKM โดย 

การน�าเสนอข้อมูลด้านความปลอดภัยด้วยภาพเคลื่อนไหว 

สามารถที่จะท�าให้บุคคลเกิดความเข้าใจในรายละเอียดของ 

ข้อมูลทีต้่องการสือ่สารได้มากข้ึน และยงัสามารถสร้างความ 

ตระหนักในการปฏิบัติงานที่ปลอดภัยให้แก่บุคคลด้วยท้ังนี ้

ส�าหรับงานก่อสร้างการจัดการความรู้ด้วย BIM-CSKM  

ยังคงมีข้อจ�ากัดในหลายด้าน และวิธีการดังกล่าวจะไม ่

สามารถประสบความส�าเร็จได้ ถ้าหากบริษัทและบุคคล 

ในบริษัทไม่ให้ความร่วมมือโดยเฉพาะไม่ยอมรับการ 

เปลี่ยนแปลงในด้านเทคโนโลยี
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